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OUTLINE

¢ Scheduling with Microsoft Project
¢ Introduction
¢ Microsoft Project Steps
¢ Interface (menus and dialogues)
¢ Critical path method in Microsoft Project

¢ Demo
¢ Homework No. 5




WHAT IS MICROSOFT PROJECT?

>
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Microsoft Project is a
project management
software that you can use
to control projects.

It helps you schedule and

track project activities so
you can stay on top of

their progress.
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Allows many different

ways of entering and
observing information.

MS PROJECT STEPS
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Enter project information

Select view type and columns
Add tasks/subtask and durations
Set dependencies

Assign resources

Assign constraints

Save project




Step 1. PROJECT SETUP

& Enter project information

& Select project defaults

¢ Set them before starting every new
project

& Set project calendar

¢ Holidays
¢ Working hours

PROJECT INFORMATION

# Project > Project Information

T Microsoft Project - MS Project Demo.mpp g g 5 5 g ? & ]
ec (=1 =] B
id] Ble Edt Yew Inset Fomet  Jook| Project |Window Help Adobe POF Pru] t Information for "MS Pru] t Demo mpp r_| _|
PINEEHRIGRYT ERB S8 =50 H
P@ 9| A (A G @ Favorites~ | Go~ | 5] | C\Z008lYSUCHOBecturesis-Praject Start date: m j
Hiel \ ~ | Resources + | Track v | Report ~ ! o) -\5!
Firish date: | Thu 42601 -
a Tazk Name % Complete Dur
1 [ hree-story Office Building (76,000 square feet) 0 3 Schedule From: |Project Skark Date j
2 0%
j = Al tasks begin as soon as possible.
5 0%
i o Current date: |Mon 11/19/07
7 o

Status date: |N-°-

Led Lol Lo

Calendar: | Standard
Priarity: 500 ::I
Help | Statistics... | Ok I Cancel |

.\..\.\2008\Y SUCMO8\L ectures\6-Project
Management2\MS Project Demo.mpp




PROJECT DEFAULTS

# Tools > Options > View

I Microsoft Project - MS Project Demo.mpp tions
() Ele  Edit View Inset  Format Project  Window Help  Adobe PDF I
3 o - ” Calculation Spellin “Workgrow Save
NEEBGR TR BB e | B karoup
g 1
P@ 9| A (A G @ Favorites~ | Go~ | 5] | C\Z008lYSUCHOBecturesis-Praject General Edit Calendar schedule ]
+ | Resources - | Track  ~ | Report + ! £ ! Bk afzme |Gantt Chart j
@ |TaskName % Complete| D Date Format: |MDr| 1/3100 |
1 . i o w
:la Three.story Office Building (76,000 square feet) 0% 3 e
2 £l General Conditions IR
3 Receive notice to procesd and sign contract 0% ¥ 5tatus bar ¥ 5croll bars V¥ GLE links indicatars
hd Sulomit bonel and insuranee documents o ¥ windows in Taskbar ¥ Entry bar ¥ Project screentips
5 Prepare and submit project schedule 0%
€ Prepare and sukmit scheduls of valuss 0% Cross project linking options For ‘M3 Project Demo.mpp’
T ST —— . . 3
fremn " " ¥ Show external sucressors ¥ Shows Links Betwesn Projects dislog on open
¥ show external predecessors [

Currency options for 'M3 Project Demo.mpp'
Symbol: $ Decimal digits: 2z ::‘

Placement: $1 -

Qutling options for ™S Project Demo.mpp’
¥ Indent name ¥ show summary tasks
I™ Show outline number ™ Project summary task
¥ Show outline symbal

Help Cancel

PROJECT DEFAULTS

o Tools > Options > Schedule

10

Save I
Calendar Schedule

Workgroup

Calculation spelling
Edit

Vigw General
Schedule options For Microsoft Project
¥ show scheduling messages

Show assignment units as a; Percentags ~

Scheduling options for 'MS Project Demo.mpp

[lew basks: ,m
Duration is entered in: Days ~
Work is entered in: 'Hou’s—L‘
Default task bype: Fixed Linits -

[V Mew basks are effort driven

¥ putalink inserted or moved tasks

W Split in-progress tasks

¥ Tasks will slways honor their constraint dates
¥ Show that tasks have estimated durations

¥ Mew tasks have estimated durations Set as Default
Ip Cancel




PROJECT CALENDARS

# Tools > Change Working Time

hange Working Time

For: |Standard (Project Calendar) j
Set working time For selected date(s)
egend: 2lech Datels ) 2l seleche atels) [og
Legend Select Dat et selected date(s) b
Working Movember 2007 - & Use default
SIM]T W :h 2F ; = Morwworking kime
i ondefaul working time:
Horwarking " Mondefault working £
) ) 4 s e |7 ]2 |9 |10
Edited working From: To:
hours 11 [12 [13 |14 |15 [16 |17
|3:00 aM |12:00 PM
On this calendar:
Edits to 2 day of 18 [T5 |20 [21 [22 [23 |24 [1:00 PM [5:00 P
1] the week 75 |26 |27 |28 |28 |30 | |
Edits to an
individual day 3 | |
Help e Options. .. | (o4 | Cancel
9
STEP 2. SELECT VIEW TYPE AND
plete Finist
COLUMNS
0% ) - el Thu 4%
= 0| £l
0% = Tue 1/
H Paste
¢ Task Sheet view E Bk e
0%, Paste Spedial... Frit
+ In View Bar, double click More Views and select Tas  k Sheet Insert Colurn... Tue 17
0% W Hide Column That?
¢ Recommended for initial task entry 0%, = Tus 17
%) Al Eort... Tue 1/
+ Add or hide default columns as necessary 0% REE e Tou 1
0% Custornize Fields... Thu 4
¢ Select column & 0% Sort by... That
ri ht C|| Ck B Fe Edt yew Inert Fomat Toos Broject Window Help AdobePOF 0% ””7 Tue 202
g DEHGRY 4BBI @/ =®(ESE woow - g Wed 12600 TueZ
€ & & = show~ Arid *8 ~BZ U EEFEF Aasks - Ve .l
P'S Sug g eSted | le-¢ 3 @ Favortes - | Go~ | [F]| Cibocumentsand etingeushansl CHESTERYAY Documertsi b - B Wied 172600 Tus 2
. | BT T T R =]
columns: | o T i e B F
2 5 Ganore Contons o fTdms Montee| Tuetz5Ro
5 Rocove e lopomasd s s | %] 3vers| 10| Wad 1500 —
J S s o s ot T T e e ——
# Task Name : s L
. Sk S i O] s WIS RG] |5 Corsminapman W07 Frod W
7 Obtain buikiing permis 0% 4 days. Thu1/B/00  Tue 141100 3 G.C. Project Management[50%] G.C. Procurement(S0%]
¢ % Complete : S g D fer| T Tl (o6 rop D Posrraod
e Rl b P e T
i S o o T i OK| w0l Ti000 | Seaacion oMot
’ Duratlon m 12 ‘Subm shop drawings and order long lead el 0% 2wks Wed 126100 Tue 2/800 8 Roofing Contractor Management
¢ 13 ‘Submit shop drawings and order long lead el 0% 2wks Wed 126100 Tue 2/8100 8 Elevator Contractor Management
i Sl i v s g e OX| W TG TS R Cocie amiimad
< Start - Sk s 4eves o oG el V501 Tin 38606 | Cover et
® o o wovegs s orr el 0% 2w hd 12500 Ton 79008 [RWAC CartolrManapernt
inish " et e ant e s 08 2wis PTEI00] T 4HA/11 | Ses rsionCrrce g eSS ek
# Finis . e e e
= eyl srves O] 2dwe| TS| FAIRSlS [P Garacor
¢ Predecessor : Bt o s e
= I v sty conn yrdariorprayi| 0% ZdwaTuo 100 Wad 11900 22 | ke Grdig Cntrocir 0. L Gow{10%]
s | 8  Ste Graiog and s o Ssdge Thatoens| Wed 38R0
* Resources s Ciear and grub st 0% Soays  Thut000 Mon1Pm0 2125 Ste Grading Contractor
g Sone st scoses avonpa o o] O%| Zdoal T 12500] Wed 12005{3525 ke Grding Cortroc
g oot o Gk s ) Tt TTETR VerZaeil® [5G e ]
A 0% 2wke Thu2300. Wed 211600 27 Ste Grading Cortractor J—H
A 5
Ready. ) UM 4




GANTT CHART VIEW

& hitp:/www.k state.edu/infoTech/epmitraining/MSProject-101/My%20Shed3a.mpp - Microsoft Internet Explorer

File Edt View Inset Fomet Tooks Project AdobePDF GoTo Faverites Help w

Qo - Q[ B @ POsewar slernonss € M - %3 L) E 3

Address |&] http: Kestate i - 101 My%205hed:

R~ K

o

[TaskName % Completa | 125,05 i3, 05 10,05 17,05 124,05 i, <
| MITWITIF[S|SMITWIT[F]S|STM[TWI[T[F[S|SM|T W[T[F[S|SIM[TWI[T[F[S|SM|T[W[T[F

o ly Shed3a 8%

Tl Ortier kt & scheclle o 100% [ Johwsboe(n.25]

il =l Preparation 100% - 7

3 | Site preparation 100% ] JohiDoe[0.5]

5 |/ Receive the delivery 100% JohnDoe[o.13]

6 |o Delivery misstone 100% ‘ .L 12
7 = Assembly 0 T .

bl © = Assemble ki o TR

g Stain the shed 0% T
a Plant lanciscaping 0% o
1 Filthe shed % &

S R} j:l

& Unknown Zone

STEP 3. ADD TASKS / SUBTASKS AND
DURATIONS

a Start

Summary Task s [£] Inventory and research. 1 day? Mon 625101

Invertory artifacts 1 day?|  Mon 6725101
l Subtas.ffs} 3 1o Arrange for loans 1 day?  Mon B/25/101

e Pick up donations 1 day?| Mon 625101
=l Design and Developme: 1 day? Mon 652501

Taszk Mame ‘ Dwration




Adding Tasks and Durations

& Microsoft Project - DemoProject mE =

| @ File Edit Wiew Insert Format Tools Project ‘Window Help iliﬂ m
DEHERY imad va@®=mp  EaQar @kl
¢¢+--‘E++|nria\ I Blg‘ggghmam e

a |Task Mame

| Duration | Start ‘ Finish |Predecessors |\

Sep19,'99 SEp 2 a

= [M[T [T [F[E S\MJ

Project definition task
2 Intial Meeting of MU Team
3 First contact with int. ptner

&

Sdays  Mon 9520099 Fri9/24m9
2days Mon 92083 Tue9/21/93
1day Mon920/89 Mon9/20M99

Just enter data on a blank row
or double click on a blank row
to enter data in Task
Information window.

‘ Ready

i Start I&Micmsnﬂ Project - D_. | [=]Microsoft

PowerPoint - [DE...l EQHP DeskJet Toalbax I

3 K
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TASK INFORMATION WINDOW

¢ Double click on a task

¢ Durations

¢ Dependencies
(predecessors)

¢ Constraints

¢ Milestone tasks

General: }Predecessors] Resources }

advanced | motes | costom Filds |

Mame: ‘Ohta\n building permits

Percent complete:; 0% :‘

Dates

Duration: [4d | I Estimated

Priority; [500 :‘

Start: |Thu 1/6/00

I™ Hide kask bar
™ Roll up Gantt bar to summary

Help

Finish: [ Tue 1/11/00 -




“Rolling up” subtasks (using indent and outdent butt

‘& Microzoft Project - DemoProject [_[=]x<]B
x|

@Eile Edit Wiew Insert Format Tools Project Window Help

ons)

LEH @Ry i2ad v e®|=puaesE QAT |(asD

<-¢+-:Q++‘ana| <8 =B I U E|AI\Tasks T
| Indent IImtlaI Meeting of MSU Team
" . 19,'88 Sep 26,'99 Cal
(1} ‘Task Marme |Jura1|or| Start | Finish |Predacesso m |T |W|T |F |S 5 |M | T |W\T |F \S SJ
[=] Project definition task | #%%#%%% Mon 9/20/99 Mon 9/27/99 p 0%
Initial Meeting of MSU 2 days | Mon 972089 Tue 9/21/99
First co udl 1 cay | VWed 5/22/99 | Wed 9/22/59 2
Wed 9/22/99 ) Thu 972399 2
Fri 9/24/99 Mon 9/27/39 4 0%
hion 8/27/99 Mon 9/27/89 5 127

e

‘ Ready

il Start I&Micm:nll Project - D.__ | =] Microsoft PowerPaint - [Da...I A HP Desklet Toolbox |

EXT [ [ | SR e
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TASK TYPES

« Double click on a task or subtask to open Task Info

window.

Task Information

General l Predecessors ]

Resources

Advanced l Tokes

Mame:
Constrain task

Deadline:

|Receive notice ko proceed and sign contr - Duration: | 3d

CE—

il ™ Estimated

Constraint bype: | as Soon As Possible

Calendar:

WES code:

j Constraint date: A j

~ |V Effort driven

r

™ Mark task as milestone

Help

Cancel

[ ]
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TASK RELATED DEFINITIONS

¢ Work: The total labor s i 1 o
required to complete a task. “TUEEE e
¢ Duration: The total span
of active working time
that is required to
complete a task.

¢ Resources: Labor ®
H Genersl | Predecessors  Resources I aAdvanced | Motes | Custom Fields |

Categ O rl eS (m ar! ag e r’ Name:  [DEGTEERRESRN®  pwation: [+ = [ Estimated
engineer, technician,
etc.)

+ Units: The percentage
of a work resource's
time the resource is L
assigned to a task. [

Prepare and submit project schedule 20 hrs
Prepare and submit schedule of valuzs 17.6 hrs
Obtain building permits 32hrs
Submit preliminary shop drawings 80 hrs

O @~ m o e W a =

Submit merthly recuests for paymert Ohrs

-

TASK TYPES

o Three types:

1. Fixed duration: Duration is fixed and changes to the work
or the units don't affect the duration.

+If you revise duration, Project recalculates work.

2. Fixed units (default): Units are fixed and changes to the
amount of work or the duration don’t affect the resources.

+If you revise units, Project recalculates duration.

3. Fixed work: Amount of work is fixed and changes to the
duration or the units do not affect the work.
+If you revise the amount of work, Project recalculates
duration.
+ Effort Driven check box: the duration of a task shortens or
lengthens as resources are added or removed from a task
while the effort (work) remains the same.

+Check box is automatically selected for fixed-work tasks.




MILESTONES

¢ Check “Mark task as milestone” for milestone tasks

deadlines)

+ Obtain authorization to proceed from the client

+ Submit preliminary design documents
& Submit final design documents

Task Information

General

Advanced |

I Predecessars I Resources

Nokes

[

[Hame: Duration: | led

:j’ ™ Estimated

(usually with

2

| Customn Fields

Constrain task

Deadline: HA h

Constraint type: | As Soon As Possible vI Constraint date:  [ra

Task bype: Fixed Linits 'I ¥ Effart driven
Calendar: Paone 'I I™ 5cheduling ignores resource calendars
WHS code: 2

|% Complete 'I

Earned value method:

¥ Mark task as milastona_

Mark as milestone

Help |

O I Cancel |

Step 4: Set Dependencies (predecessors)
& Microsoft Project - DemoProject [ _ |
@ File Edt Wiew Insert Format Tools Project Window Hslp Bl x| q
TozEeaky 2 oaw =
4-»+--'Pc++|nria| =0 v|31g|§ ‘AIITasks
0 - 19,'88 Sep 26,'99 CA|
(1} Task Name Jurat|0r| Start | Finizh |Predecesso M|T |W|T |F \S = \M \T \W\T \F \S =
1 Project definition task G days | Mon 9/20099 Mon 972799 0%
2 Initial Meeting of MSU Tean 2 days | Mon 9720099 Tue 972199
3 First contact with int. ptnet. 1 day | Wed 9/22/99  Wed 9/22/9982
4 Meet with indust. Sponsor | 2 days | VWed 9/22/99 Thu 9/23/9982
5 Discuss with whole team | 2 days | Frif/24/89  hon 9/27/9984 T 1%
Task Information, E‘
General | Resowses | advenced | metes | CustomFielss |
Wame:  [OBtain buiding permits Duration: [+ :‘ I~ Estimated
Predecessors:
3 ~
D Task Name Type Lag =
EW = =cciv= notice ko procesd and sign contract Finish-ta-Start (F5) _ 0d 0
a
d
v
|1 | ¥
| Help Cancel
iﬁSlaltl &7 Microsoft Project - D | (=] Micrasaft PawerPaint - [U...| T AT Desklet Tooloor T [ IR A
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Step 5. Assign Resources

& Wicrosoft Project - DemoProject ____________________________MHEH]
—_ @ File Edit VYiew Insert Format Tools Project Window Help ilﬁ“ Ea
DEH ESRY IaRY we@®(epinDcB QAT @il

¢¢+--“Q++|Aria\ SE
|JoaJTinaJEarb

B I U| || Tasks .

£l Qct 3,'99 Oot 10« |
[TIF[E[EM]T [W]T[F[E S|M|_‘

)uraﬂor| Start | Finish |Predecesso| Resource Names
A4 Mon 920099 Mon 92799
2days Mon 902099 Tue 921599
1 day VWed 92299 \Wed 9/22/99 2
2days | Wed 922089 Thu9r2389 2
4
s

2days  Fri9f24/899  hon 92799

Ochays Mon 902789 Mon 952799

A Mon /2799 Fri10/6:99 6F5-1 day
1 day  Mon S/27/83 0 Mon 952789

2days Mon 92789 Tue 92599 0%
1 day | \Wed 928098 \Wed 9729038 |9

A Thu 993009 Fri10/ama 10

Odays| Fri10/8809 Fri10/899 11

Sdays| Maon10/499 Vwed 10/6:99

Task Information,

it Toe 10583 Tha 1021799 o [ | s | B || oo e

4 days| Tue 10583 Man 10A1/83 11F5-3 day: tore: | [EETEROVRNE - gtons [*5 ] oo

ey Thu107@8| Thu107s8 13 ..ot anagement ]

Sdays| Fri108m89 Thu 101499 16 o

2days| Fril0AS8G) Mon 101883 17 . e

ddays| Fri10R89) Wed 101399 16 =

3 days Tus 101983 Thu10/21/88 18

YR ErNY TPy BTy oy

_i - J

|Rsady’ |‘ - | |
%ﬁﬁlald 2 Exploring - GoodmanPraje... ”&Miclusufl Project - D._. | [&]Microsaft P = el | I 21

Assigning Resources (using Resource Sheet)

Elevator Cortractor  Wiork
Elevator Cortractor b Wiork
L0 Steel Erection Coml|Work
Steel Erection Contrac VWork
Dryweall Contractor Work
Maszonry Contractor  Work
Tile Cortractor Wiork

= Z O ww mm

& Microsoft Project - DemoProject
@Eile Edit Wiew Insert Format Tools Project Window Help illﬂ

Dedehy e slee=cnmagaas s sn

e -: B 7 U ||l Resources - 7=
[
i) |Hesnurce MName Initizls ‘Grnup Max. Linits | Std. Rate: Cwt. Rate Costilse  |Accrue At |Elas;|
Joe J 100% $0.00Mr $0.00Mr $0.00 Prorated Stad
Tina T 100% $0.00mr $0.00mr §0.00 Prorated  Stal
Bill B 100% 0 00mr 0 00mr $0.00 Proratedd Stal
Bark B 100% $0.00Mr $0.00Mr $0.00 Prorated Sta

FERT
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STEP 6. ASSIGN TASK CONSTRAINTS

¢ Task Information >
Advanced tab

+ Constraint types

General 1 Predecessors I Resources Advanced 1 Motes 1 e I
1. Aslate as pOSSIble BCenes |Three Duration: |5\:I :I ™ Estimated
2. As soon as pOSS|b|e Constrain task

(default) Deadline: e -

* PrOjeCt SCheduleS the Constraint type: || n A e ~  Constraint date: ,N,Qij
earliest possible start

.. ble:
and finish dates for the Task type: Finish Mo Earlier han I Effort driven
task Finish Mo Later Than

r

Epiay PMust Finish On

. Finish no earlier than s cade: st seart On
Start Mo Eatlier Than
Earned walue method: Start No Later Than

. Finish no later than

™ Matk task as milestone

3
4
5. Must finish on Help Cancel
6
7
8

. Must start on
. Start no earlier than
. Start no later than

23

@ Microsoft Project Help

CONSTRAINT

W Constraint types
As Late As Possible With this flexible constraint, Microsoft Office

Project 2003 schedules the latest possible start and finish dates for the
task, given other scheduling parameters, This is the default constraint
for new tasks for a project scheduled from the finish date.

As Soon As Possible With this flexible constraint, Project schedules

183

the earliest possible start and finish dates for the task, given other
scheduling parameters. Mo additional date restrictions are put on the
task. This is the default constraint for new tasks for a project scheduled
from the start date.

Finish No Earlier Than This moderate constraint indicates the

earliest possible date that this task can be completed. It cannot finish
any time before the spedfied date.

For projects scheduled from the start date, this constraint is applied
when you type a finish date for a task.

Finish No Later Than This moderate constraint indicates the latest
possible date that this task can be completed, It can be finished on or
before the specified date.

For projects scheduled from the finish date, this constraint is applied
when you type a finish date for a task.

Must Finish On  This inflexible constraint indicates the exact date on
which a task must finish, Other scheduling parameters such as task
dependencdies, lead or lag time, resource leveling, and delay become
secondary to this requirement.

Must Start On  This inflexible constraint indicates the exact date on
which a task must begin, Other scheduling parameters such as task
dependencies, lead or lag time, resource leveling, and delay become
secondary to this requirement.

Start No Earlier Than This moderate constraint indicates the
earliest possible date that this task can begin. It cannot start any time
before the spedfied date.

For projects scheduled from the start date, this constraint is applied
when you type a start date for 3 task or drag 2 Gantt bar.

Start No Later Than  This moderate constraint indicates the latest
possible date that this task can begin. It can start on or before the
spedcified date.

For projects scheduled from the finish date, this constraint is applied
when you type a start date for a task.




STEP 7. SAVE PROJECT

& Miciosoft Project - DemoProject =[=] ]
& File Edt Wiew Inssrt Format Tooks Frojsct Window Help ilil| m
DeHesRy taed »  a® ==k c6 adsy all g
€ s & - F % <o B s ouEE= A -7 g
[
(IR [Oct 10, 98 ct17,'99 (-|
() k| S S ) i B S S T i i A S S L WA A
saveln: [ GoodmanProjectemo | QI l_ = [ .
DemoProject Save I , m
EDGMSProjDemo —
Cancel E
CDEC...
Options. ., mln%
#0721
File pame: [CriginalPlar] =
Save as type: IPrD]EEt =l
Also save periodically and after each step ‘ -~
n
0 Kl [ i SS
|‘ ERAE IREAPST IR OHE S SERE FRETH)
1147 M

R 5tart | (3] Exploring - GoodmanProie... |[& Microsoft Project - D... | |1 Miciosoft PowerPaint - De
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CRITICAL PATH IN MS PROJECT

> Helpful to know what tasks
are on the critical path

> MS Project can show such
tasks in Red color

» Useful to try to shorten the
critical path

26
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NETWORK DIAGRAM
SHOWING CRITICAL PATH (IN RED)
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Summary

o Tip of the iceberg (much more capability)

¢ MS Project is a tool that aids planning, it
won't plan for you.

¢ Need to invest in mastering the tool.
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HOMEWORK No. 5: COMMERCIAL CONSTRUCTION

» This is an individual
homework

» Create a MS project file to
create a Gantt chart
project schedule for the
data shown here.

» MS Project is installed in
the computer lab.

» Use start date of January
3,2011

» Use constraint type of “As
soon as possible” for all
tasks.

» Report the project duration

(calendar days) and finish
date.

Task / Subtask Duration Predecessor
(Calendar Days)
Task 1. Three-story Office Building (76,000 square feet)| Calculate (?)

1.1 Mobilize on Site 10

1.2 Site Grading and Utilities 35 1.1
1.3 Foundations 33 12
1.4 steel Erection 45 13
1.5 Form and Pour Concrete - Floors and Roof 85 1.3
1.6 Carpentry Work 15 1.5
1.7 Masonry Work 110 1.4
1.8 Roofing 31 1.7
1.9 Window wall and store front closures 60 L7
1.10 Building Finishes 30 1.8
1.11Elevators 40 14
1.12 Plumbing S0 1.7
1.13 Electrical 139 111
1.14 Heating and Ventilating - AC 180 1.4
1.15 Final Clean-up and Occupancy 60 1.9
1.16 Complete Final Inspections 6 1.15

29

HOMEWORK No. 5

& Microsoft Project - HW5S.mpp

i|v] @ja ]

» Print and submit the
Gantt chart view
(example shown
here).

» Show columns for:

> ID

» Task Name
» Duration

> Start

» Finish

Page: 10f 1

[ —— = e ——
Cee Fnaaant
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